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Limited Hardware and Software Warranty  

This Solmetric software and the Solmetric SunEyeTM hardware (ñHardwareò) are 
warranted against defects in materials and workmanship for a period of one year 
when purchased in the United States or two years when purchased outside the 
United States.  During the warranty period, Solmetric will, at its option, either repair 
or replace products which prove to be defective.  The warranty period begins on 
the date of shipment.   

For warranty service or repair, this product must be returned to the appropriate 
authorized repair center listed in the Solmetric SunEye Userôs Guide.  No returns 
will be accepted without an RMA (obtain from Technical Support). For products 
returned for warranty service, the Buyer shall pay for shipping charges to send the 
product to the repair center, and the repair center shall pay for shipping charges to 
return the product to the Buyer.  However, the Buyer shall pay all shipping 
charges, duties, and taxes for products returned to the repair center from a country 
outside of the United States. 

The forgoing warranty shall not apply to defects resulting from improper or 
inadequate maintenance by the Buyer, unauthorized modification or misuse, or 
operation outside of the environmental specifications for the product.  
Unauthorized modification includes disassembly of the Solmetric SunEye 
hardware, removal of any part of the Solmetric SunEye hardware, modification to 
the operating system or operating system settings of the Solmetric SunEye, or the 
installation of software on the device other than Solmetric SunEye software. 

The design and construction of any system or building by the Buyer is the sole 
responsibility of the Buyer.  Solmetric does not warrant the Buyerôs system, 
products, or malfunction of the Buyerôs system or products.  In addition Solmetric 
does not warrant any damage that occurs as a result of the Buyerôs system, 
product, or the Buyerôs use of Solmetric products. 

To the extent permitted by applicable law, THE FOREGOING LIMITED 
WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES OR CONDITIONS, 
EXPRESS OR IMPLIED, AND WE DISCLAIM ANY AND ALL IMPLIED 
WARRANTIES OR CONDITIONS, INCLUDING ANY IMPLIED WARRANTY OF 
TITLE, NONINFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE, regardless of whether we know or had reason to know 
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of your particular needs. No employee, agent, dealer or distributor of ours is 
authorized to modify this limited warranty, nor to make any additional warranties. 

SOME STATES OR COUNTRIES DO NOT ALLOW THE EXCLUSION OF 
IMPLIED WARRANTIES, SO THE ABOVE EXCLUSION MAY NOT APPLY TO 
YOU. THIS WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU 
MAY ALSO HAVE OTHER RIGHTS WHICH VARY FROM STATE TO STATE 
OR COUNTRY TO COUNTRY. 

Limited Remedy  

Our entire liability and your exclusive remedy shall be the replacement or repair of 
any Solmetric hardware or software not meeting our Limited Hardware And 
Software Warranty which is returned to an authorized repair center with a copy of 
your receipt. 

IN NO EVENT WILL WE BE LIABLE TO YOU FOR ANY DAMAGES, 
INCLUDING ANY LOST PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL 
OR CONSEQUENTIAL DAMAGES ARISING FROM THE USE OF OR THE 
INABILITY TO USE THE SOLMETRIC SOFTWARE OR HARDWARE (EVEN IF 
WE OR AN AUTHORIZED DEALER OR DISTRIBUTOR HAS BEEN ADVISED 
OF THE POSSIBILITY OF THESE DAMAGES), OR FOR ANY CLAIM BY ANY 
OTHER PARTY. 

SOME STATES OR COUNTRIES DO NOT ALLOW THE LIMITATION OR 
EXCLUSION OF LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL 
DAMAGES, SO THE ABOVE LIMITATION MAY NOT APPLY TO YOU. 

PLEASE CONTACT TECHNICAL SUPPORT BEFORE RETURNING ANY 
PRODUCT. 
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Understand ing t he Solmetric SunEye
TM

 

The Solmetric SunEyeTM (patent pending) provides complete solar access and 
shade analysis in an integrated powerful hand-held tool for the following uses: 

Á Solar panel system design and installation 

Á Passive solar house design and green architecture 

Á Landscape design and landscape architecture 

Á Home and property inspection 

Solar Panel  Design and Installation  

The Solmetric SunEyeTM is an invaluable tool for the professional solar installer, 
saving time and money and helping to design the highest performance systems. 
Home and business owners who care about the performance and payback of their 
systems hire installers that use the Solmetric SunEyeTM.  Itôs equally useful for PV, 
passive hot water, roof mount or ground-mount systems. The Solmetric SunEyeTM 
can help:  

Á Optimize new systems for maximum production. 

Á Analyze existing installations to solve problems of under production. 

Á Identify specific shade-causing obstructions and know instantly how much 
additional energy would be produced if the obstructions were removed. 

Passive Solar  House Design and Green Architecture  

The Solmetric SunEyeTM is the right tool for the job when you need accurate site-
specific solar access data for a new home or renovation. Optimize the orientation 
of a structure by identifying where and when the sun will shine. The Solmetric 

  Chapter  

1 



 

 

 

 

 

S O L M E T R I C  S U N E Y E T M  U S E R õ S  G U I D E 

 
2  

SunEyeTM helps you answer many different questions. For example, ñWill there be 
enough sun in the winter for passive heating of the house given the site-specific 
shading?ò, or ñHow will removing the large oak tree on the south-west corner affect 
the warming and cooling of the building?ò   Furthermore, by collecting data inside 
an existing structure, you can identify the amount of direct sunlight that will enter a 
window or skylight or identify the perfect location for a new window or skylight. 

Home and Property Inspection  

The Solmetric SunEyeTM gives professional home and property inspectors a way to 
provide their clients with important information about the solar access of a 
property. This information can be useful for: 

Á Identifying potential sites for solar panels, gardens, or new windows.  

Á Determining the amount of passive solar heating or cooling a particular 
building will experience.   

Á Determining how much direct sunlight will enter a particular window or 
skylight.  
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Getting Familiar with the So lmetric SunEye
TM

 

The Solmetric SunEyeTM (patent pending) includes features that make it easy and 
efficient to use. 

Á Point-and-click data gathering 

Á Instant measurement results: 

Á Plots sunpaths for the latitude and longitude of the site 

Á Determines annual, seasonal, monthly, and quarter-hourly shading 
percentages 

Á Automatically adjusts data for magnetic declination for a specific location 

Á Store more than 50 site readings on the hand-held unit 

Á Transfer data to desktop PC for later review 

Á Desktop Companion software for desktop PC automatically generates 
reports and exported data files 

Á Hand-held, all-in-one tool with Integrated fish-eye camera and processing 
software 

Á Easy-to-use finger-driven touch screen interface 

Chapter  
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The Solmetric  SunEye
TM 

 

1 Fisheye lens and digital 
camera  

7 Device/USB and charge port 

2 Compass  8 5-way navigation button 

3 Bubble level 9 Soft reset pin-hole 

4 Power on/off button 10 Neck strap attachment points 

5 Touch screen and LCD 11 Tripod mount 

6 Protective cover   
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Installing the Solmetric SunEye TM Desktop Companion Software  

Before you start using your Solmetric SunEyeTM it is recommended that you install 
the Solmetric SunEyeTM Desktop Companion Software.  Although you wonôt have 
any data to analyze on the desktop yet, this will allow you to view the Userôs 
Guide. 

Minimum system requirements: 

Windows Vista, Windows XP SP2 (Professional, Home, or Media Center), 
Windows 2000 SP4, 700 MHz, 256 MB RAM, 20 MB hard drive space, MS 
Internet Explorer. Systems that do not meet these requirements may not operate 
correctly. 

Installation Procedure 

1. Insert the CD-ROM that came with the Solmetric SunEyeTM into the CD drive 
on your Windows desktop computer. 

2. If the welcome screen does not automatically open, click Start then My 
Computer and double-click on the CD drive.  Then double-click on 
setup.exe. 

3. Follow the instructions in the welcome screen to install the Solmetric 
SunEyeTM Desktop Companion Software and update the software on the 
Solmetric SunEyeTM device.  If not already installed, the installation will install 
Microsoft ActiveSync (for Windows XP and Windows 2000) or Windows 
Mobile Device Center (for Windows Vista) which is needed to communicate 
with the Solmetric SunEyeTM device.  

4. You can view the Users Guide from the welcome screen by clicking on the 
ñView Solmetric SunEyeTM Users Guideò link in the welcome screen.  You will 
need a PDF reader to view the Users Guide.  You can install Adobe Reader 
by clicking on the ñInstall Adobe Readerò link. 

If at any time the Solmetric welcome screen is not showing, click on the 
Solmetric installer icon in the task bar at the bottom of your screen.  If the 
welcome screen is accidentally closed, click on setup.exe from the CD-ROM 
as described in step 2 or re-insert the CD-ROM to automatically launch.  

5. During the installation, the device connectivity software will try to connect to 
the Solmetric SunEyeTM device.   
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For Windows 2000 and Windows XP, and Solmetric SunEyeTM devices 
labeled with ñSunEye-100N v2ò, ActiveSync will automatically start the 
ñSynchronization Setup Wizardò.  

 

Select ñCancelò to exit this dialog. 

6. You can now launch the Solmetric SunEyeTM Desktop Companion from the 

Solmetric SunEyeTM icon on your desktop or from the start button:   > 
All Programs > Solmetric SunEye > Solmetric SunEye 

If this is the first time launching the Solmetric SunEyeTM Desktop Companion, or 
there has never been data transferred from the Solmetric SunEye hand-held 
device, then there is nothing that can be done on the desktop at this point other 
than view the Userôs Guide. The screen you will see looks like this: 

 

 

7. You can view the Userôs Guide by selecting Help > Solmetric SunEye 
Userôs Guideé 
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NOTE You must have Adobe ReaderÈ installed in order to view the Userôs 
Guide.  Adobe Reader can be installed from the CD-ROM welcome 
screen (setup.htm).  Simply click on ñclick here to install Adobe 
Readerò. 

8. You can exit the application by selecting File > Exit. 

System Control s and Settings  

Power Button 

Á Pressing the power button switches on or off the Solmetric SunEyeTM device.   

Á Pressing the power button and holding it for 4 seconds when the device is 
on, switches off the backlight without powering down.  

 ͙ Pressing and holding the power button again for 4 seconds switches the 
backlight back on. 

NOTE For proper operation it is important to maintain the charge of the 
battery even when not in use.  Prolonged storage will result in the slow 
discharge of the battery.  When the SunEyeTM is not in use, it should be 
connected to AC power or to a computer with the Device/USB cable.  
It is not harmful to the device to be continuously connected to AC 
power or to a computer   

Touch Screen 

The touch screen is the main interface that you will use to interact with the 
Solmetric SunEyeTM.  Although a stylus has been included, it is not necessary for 
general operation.  The user interface has been carefully designed to allow easy 
control using your finger alone.   

Á Touching your finger tip to the screen is similar to moving a mouse cursor or 
other input device on a personal computer screen.  

Á Tapping your finger on the screen is similar to clicking a mouse.  

NOTE You will find that your fingernail works better than the fingertip on the 
touch screen.  
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Five-Way Navigation Button 

 

 

 
 
 

 

There are other specific uses of the 5-way navigation button that are described in 
the following sections and chapters. 

NOTE The Solmetric SunEyeTM uses an HP iPAQ as the processor and user 
interface.  However, this iPAQ may not be removed from the device, 
and there is no access to the operating system of the iPAQ.  Attempts 
to remove the HP iPAQ, modify the operating system settings, or 
install software other than the Solmetric SunEyeTM software will void 
the warranty.  

Neck Strap 

Your Solmetric SunEyeTM came with a neck strap.  You may attach the strap as 
follows: 

1. The ends of the strap webbing are run twice through buckles on each end of 
the strap.  Open one of the loops by removing the strap webbing from the 
buckle so that the webbing only passes once through the buckle. 

2. Insert the webbing through one of the neck strap attachment points on the 
base of the Solmetric SunEyeTM. 

3. Pass the webbing back through the buckle. 

4. Repeat for the other end of the strap.    

5. There is a small elastic loop on the strap to place the SunEyeÊ GPS.  

The five-way navigation button can also provide input to many of the 
navigation features displayed on the Solmetric  SunEyeTM  screen. For 
example, you can use the five-way navigation button to scroll through 
menus: 

Á Pressing the center button brings up the main menu. 

Á Pressing the left, right, up, or down button changes the selected 
menu item. The menu selection is highlighted in blue. 

Á Pressing the center button again selects the highlighted menu 
option. Small arrows show possible directions that can be 
pressed on the button to move to the next menu. 
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Cover 

Your Solmetric SunEyeTM has a protective cover that folds open when in use.  
When you are capturing data, open the cover entirely so that the compass is level.  
The cover can also be used as a visor to shade the sun from the LCD display and 
improve visibility. 
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The SunEye Ê GPS  

The SunEyeÊ GPS can acquire your current location when creating or modifying 
a session and when acquiring skylines.  

 

GPS Controls 

  

                   

1 Power jack (mini USB) 4 Bluetooth status LED (blue) 

2 Power switch 5 GPS status LED (orange) 

3 Battery status LED 
(red/green) 

6 Internal antenna 

LED Display 

The Solmetric GPS has three LED lights, one for the Bluetooth status, the second 
for the battery status, and the third for the GPS status. 

 Color Status Function 

1 

3 

2 

4 

5 

6 
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Bluetooth Status 
LED (4) 

Blue Always on Bluetooth not connected  

Slowly blinking Bluetooth is in sleep mode 
for low power consumption 

Quickly blinking Bluetooth is connected 

Battery Status 
LED (3) 

Red Blinking Battery is low, charge the 
GPS 

Green Always on Battery is charging 

Green Blinking Battery is fully charged 

GPS Status 
LED (5) 

Orange Always on Acquiring satellites, GPS 
position not fixed 

Blinking GPS position is fixed 

 

Power Switch 

Á Sliding the power switch (2) toward the center will turn the GPS on.   

Setting up the S unEyeÊ GPS 

Charging the Battery 

Á Before using your SunEyeÊ GPS, you will need to fully charge the 
battery.  Plug in the GPS power cable and connect it to the GPS power 
jack, this will begin to charge the battery.   

Á When the battery is charging, the battery status LED will be solid green.  
When the battery is fully charged, the battery status LED will blink green.  
When fully charged, the GPS will operate approximately 24 hours. 

Á When the battery status LED is red, the battery is critically low, and the 
GPS will need to be charged again.  Low battery power for the GPS or 
the Solmetric SunEyeÊ may affect signal reception.  
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Creating a Bluetooth Partnership 

Á The Solmetric SunEyeÊ communicates with the GPS using Bluetooth.  
Before using your SunEyeÊGPS, you will need to create a Bluetooth 
partnership between the Solmetric SunEyeÊ and the GPS.   

Á Turn on the Solmetric SunEyeÊ and the GPS.  Select  then  to 
access the utility features. Select GPS Setupé , from the GPS Setup 
dialog, select New GPS.  The Solmetric SunEyeÊ will search for a 
SunEyeÊ GPS, this may take a while since it is locating all Bluetooth 
devices in the area.  A partnership will be created when the SunEyeÊ GPS 
is found.   

Á If you want to use a different SunEyeÊ GPS with your Solmetric 
SunEyeÊ, you will need to create a new Bluetooth partnership with the new 
GPS. 

Á See the section Create a Session on page 15 for using the GPS to 
acquire the session location.  See the section GPS Setup on page 38 for 
automatically acquiring the location for each new skyline. 

NOTE If when trying to create a Bluetooth partnership, a SunEyeÊGPS was 
found with an invalid ID, you may need to upgrade the SunEyeÊ 
software to validate the GPS. Recent software is available at:  
www.solmetric.com/support. 

 

GPS Usage 

For best performance: 

 Make sure the GPS has been powered on for at least 40 seconds before 
taking your first measurement 

 In general any GPS receiver performs best in open space where it can 
see open sky.  

http://www.solmetric.com/support
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Using  the Solmetric SunEye
TM

 

This chapter contains step-by-step instructions for the basic use of the Solmetric 
SunEyeTM, including the collection of solar access data.  

Charging  the battery  

Á The battery in the Solmetric SunEyeTM is not removable. It may be 
recharged by attaching the device to a PC via the Device/USB cable or by 
using the AC wall-plug or the car charger. All cables are connected to the 
Solmetric SunEyeTM via the Device/USB port on the right side of the device.  

Á If the battery is completely discharged, you must use the AC charger if you 
want to operate the device while it is charging.  The Device/USB cable and 
the car charger do not supply enough current to both charge a completely 
discharged battery and operate the device. 

Á Charging the battery can take up to 4 hours.  Once the battery has been 
charged, the device will operate without the external power connection for 
approximately 3 hours of continuous use.    

Á When the battery is charging, the orange LED to the left of the screen will 
blink.  When the battery is fully charged the LED will be solid on.  When the 
AC cable or Device/USB cable is disconnected, the LED will be off. 

Á To see the current battery level of your Solmetric SunEyeTM, select the menu 

icon , then the utility icon ,and  then select About Solmetric 
SunEyeTM.  

Á For proper operation, it is important to maintain the charge of the battery, 
even when not in use.  Storage in the off state without the AC power or 
Device/USB cable attached will result in the slow discharge of the battery.  In 
this off state, the battery will last approximately 9 days.  Therefore, when the 

Chapter  
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SunEyeTM is not in use, it should be connected to AC power or to a computer 
that is on via the Device/USB cable.  It is not harmful to the device to be 
continuously connected to AC power or to a computer.  It is also not harmful 
to the device or to your data for the battery to fully discharge, however, if this 
happens, you may be forced to go through a series of steps including a 
touchscreen alignment and tutorial.   

Power -Up the Solmetric SunEye TM 

1. If the battery has not been fully charged as described above, connect the 
power cable to the Device/USB port, located on the right side of the 
Solmetric SunEyeTM. 

2. Press the Power button. 

Set correct Date  and Time  

3. Select the menu icon  at the bottom-left of the screen. You will see the 
Solmetric SunEyeTM menu.  

Á Alternatively, press the center navigation button to bring-up the menu. 

 

4. Select  to access the utility features 

5. Select Set Date and Timeé 

6. Enter correct date, time, and time zone.  
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Create a Session  

A session is like a site visit. You would generally create a new session for each 
new client.  Each session will generally consist of multiple skyline data sets.  The 
Session menu selections are as follows: 

Á Properties ï shows information about the current session. 

Á Browse ï allows you to view and select a previously created session. 

Á New ï creates a new session.  

1. Select the menu icon   then Session to see the session menu.   

 

2. Select New. 

You will see the New session dialog box.  

 

3. You can accept the default session name (for example, Session 1), or you 

can select the keyboard icon   next to the Session Name text box on 
the display and enter a different name.  
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4. If you pressed the keyboard icon, next select the characters from the 
keyboard to name the session.  Then select Enter. For example, if you were 
creating a session for Roger Smithôs house, you could enter the name to 
appear as shown. 

 

The keyboard entry dialog has a few features that make entering and modifying 

text quick and easy.  Select the button to switch between an alphabetical 
keyboard and a QWERTY style keyboard.  Also, as you type text, the Solmetric 
SunEyeTM predicts the words you are typing. To select the predicted word, click 
on the word where it appears above the text area, as shown in the example 
below. This feature reduces the amount of typing required to enter text. 

 

Á Click inside the text box (where the typed letters appear) to bring up the 
scroll control.  The scroll control allows you to move the cursor inside the text 
area to delete or add letters.  

Á Use the arrow buttons to move the cursor.   

Á Press Clear Text to clear all text.   

Á Click anywhere outside the scroll control box to close the scroll control. 
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Á Additionally, you can select the keyboard icon  next to the Session 
Note text box and enter a description of the session. For example, you could 
enter the address of the site or the clientôs contact information. 

 

5. Select Next to advance to the Location dialog box to enter the site location 
information. 

  

6. Select the location of the site using one of the following methods: 

Á Select a city from a list of cities.  In the Location dialog, select List of 
cities for the current region, then Next.   Select the state where your site is 
located.   
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Á Click on Next and select the nearest city to the site. 

 

The Solmetric SunEyeTM will automatically determine the correct latitude, 
longitude, and magnetic declination for the city you select.  It is not necessary to 
select the exact city since the latitude and longitude will be very similar for 
nearby cities.  The lists of states and cities available depend on the currently 
selected region; see section Select Locale on page 39.  The city latitude and 
longitude data was obtained from www.geonames.org. 

Á Use the SunEyeÊ GPS to acquire your current location.  In the Location 
dialog box, select SunEyeÊ GPS, then Next. 

 

Á Make sure your GPS is on, click on Acquire Session Location and the 
latitude, longitude and calculated magnetic declination will be acquired.  If 
you would like the GPS to acquire the location for each new skyline, check 
Get new GPS location for each skyline.  In order to use coordinates 
outside of the United States, the International license is required to be 
installed.  See the section License Features on page 39 for more 
information. 

Á Alternatively, enter the location manually.  In the Location dialog box, 
select Manual Entry. 

http://www.geonames.org/
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Enter the longitude, latitude, and magnetic declination. (If you have previously 
selected a city, the corresponding latitude, longitude, and magnetic declination 
for the selected city appear in the text boxes.)  The Calculate button will 
recompute the magnetic declination for the latitude and longitude that are 
entered.  In order to enter a location outside of the United States, the 
International license is required to be installed.  See the section License 
Features on page 39 for more information. 

 

7. Select Done. You will see the Session Properties which lists the information 
you entered for the session.  

 

8. Change weather model (United States only). In United States locations, 
there are two weather models available: NASA and NREL ï TMY3. The 
weather model used by the SunEye may impact the insolation and solar 
access calculations. To learn more about the weather models, see Weather, 
Air quality and Clouds on page 60.  
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To select the most appropriate weather model for each session, select 
Session then Weather Properties menu. Select NREL ï TMY3 or NASA. If 
NREL ï TMY3 is selected, then information about the selected NREL 
weather station is displayed. By default, the SunEye selects the weather 
station that is closest in geographical distance to the session location 
entered by the user.  The name, WBAN identification number, and latitude 
and longitude of the station are displayed, as well as the distance from the 
session location to the station location. 
 

 
To change the weather station, for example, to better match weather 
patterns at the selected location, select ñChange Weather Modelò select 
the US state or territory, then pick the desired weather station from the list. 

 

9. Change any information, as necessary. 

NOTE The time zone associated with a session is whatever the time zone 
setting was last set to (via the Set Date and Timeé dialog box) at the 
time the session is created.  Changing the time zone (via the Set Date 
and Timeé dialog box) does not change the time zone of any existing 
session(s).  It is not possible to change the time zone of an existing 
session. 

Capture a Skyline  

A skyline is the basic data set representing the solar access for a particular 
location within a session or site visit. You will generally capture multiple skylines for 
each session. For example, if you were analyzing a roof site for a new solar 
installation, you might capture a skyline at each corner and at the center of the 
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roof.  A skyline consists of a fisheye image, superimposed sunpaths, and the 
calculated solar access numbers. 

1. Select   > Skyline > New.  

Before capturing the first skyline in a new session, you will need to set the 
default skyline panel orientation for the session from the Panel Orientation 
dialog box.   

 

You can change the default skyline panel orientation by tapping on the 
Panel Azimuth and Panel Tilt numeric boxes.  If the True azimuth radio 
button is selected, then the panel azimuth entered is the true azimuth.  If the 
Magnetic azimuth radio button is selected, the panel azimuth entered is 
magnetic.   

NOTE For panel azimuth; 0° is north, 90° is east, 180° is south, and 270° is 
west. For panel tilt, 0° is flat, 90° is vertical. 

Tap the Set Tilt = latitude, Azim = 180°(S) button to set the orientation to 
the default, which is tilt = latitude, azimuth = 180° (in northern hemisphere) 
or 0° (in southern hemisphere). 

NOTE When the first skyline in a new session is created, the skylineôs panel 
orientation is set to the default skyline panel orientation.  The panel 
azimuth and panel tilt of a skyline can later be changed from Skyline > 
Properties. When a new skyline is created, the panel orientation 
always defaults to the orientation of the last skyline. 

See the section Surface Orientation on page 62 for more information. 

Set the default skyline panel azimuth and panel tilt, then select OK.  
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You will now see a live preview of the skyline through the fisheye lens with the 
correct sunpaths for that location superimposed on top.  

 

2. Be sure the protective cover is completely open so that the compass is level.  

3. For northern hemisphere SunEyeTM devices (100N and 110N), orient the 
Solmetric SunEyeTM toward the magnetic south by lining up the white end of 
the compass needle with S. This orientation is for a location in the northern 
hemisphere. For a location in the southern hemisphere, line up the white 
end of the compass needle with N to orient the device magnetic north.  

For the southern hemisphere SunEyeTM  device (110S), orient the Solmetric 
SunEyeTM toward the magnetic north by lining up the red end of the compass 
needle with N. This orientation is for a location in the southern hemisphere. For 
a location in the northern hemisphere, line up the red end of the compass 
needle with S to orient the device magnetic south.   

NOTE The Solmetric SunEyeTM automatically accounts for the magnetic 
declination, based on the location you entered for the session. 

4. Hold the instrument level by adjusting the position and observing the bubble 
level. It is level when the bubble is inside the center circle. 
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NOTE The accuracy of the measurement is directly related to how close to 
magnetic south the compass points and to how level the unit is held at 
the time the skyline is captured.  Care should be used during these 
critical steps. 

5. Press Snap or press the center navigation button.  

The Solmetric SunEyeTM performs the following tasks: 

Á Captures the entire horizon with the built-in fisheye lens and digital 
camera.  

Á Plots the sunpaths on top of the captured digital image of the skyline.  

Á Acquires the location using the GPS if this property is set in 

> >GPS Setupé. 

Á Analyzes the image and attempts to identify unobstructed open sky and 
shade-causing obstructions.  

Á Calculates the monthly, seasonal, and annual solar access percentages. 

6. Verify that the software has correctly identified the open sky and 
obstructions. You can verify that the yellow and green annotation is correct 
by looking at the image through the annotation colors to make sure 
obstructions are green and open sky is yellow. Incorrect identification will 
affect the accuracy of the calculations. Correct the annotation if needed with 
the edit tool as described below. 

NOTE Skylines are automatically saved every time they are captured. 

NOTE To delete the skyline data that you just captured, press the navigation 
button to the left. Alternatively, to immediately capture another skyline, 
press the navigation button to the right. 

7. Tap your finger on the top-right corner of the screen to enter a note for the 
captured skyline. The note could include a description of where the skyline 
was captured.  For example, you could enter ñSoutheast corner of roof.ò  
You can also enter a skyline note via the skyline properties dialog, 
described in the next step. 

8. You can view and change the properties of a skyline by selecting 

>skyline>skyline propertiesé. 
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The skyline properties dialog had two tabs, Panel and General.  The 
panel orientation for a skyline can be modified in the Panel tab. 

    

The panel orientation is changed in a method similar to setting the default 
skyline panel orientation in the Panel Orientation dialog box, see page 20 
for details.    

Other skyline properties can be accessed in the General tab. 

 

 

You can enter or change the note for the skyline by tapping on the SkyXX 
Note text box. 

If a GPS was used to make a measurement at the time the skyline was 
created, then the GPS location will be displayed. 

 

View  the Skyline Measurement Data  

You can choose from three main views of your skyline data, and one average data 
view of all skylines in your session: 
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Á Annual sunpaths view 

Á Monthly solar access view 

Á Obstruction elevation view 

Á Full fisheye view 

Á Session solar access averages 

Annual Sunpaths View 

The first display that you see after you capture a new skyline is the annual sunpath 

view.  You can also access this view by selecting >View>Annual Sunpaths. 
This view shows the annual sunpaths drawn on top of the captured skyline. The 
detected open sky is shown in yellow. The detected shade-causing obstructions 
are shown in green.  

The results panel in the lower center portion of the display can be configured to 
show solar access percentages or solar resource percentages.  

Solar Access. The annual and seasonal solar access is shown in the results panel.  
The seasonal month ranges, May-Oct and Nov-Apr, represent the common peak 
and off-peak rate seasons. Your local utility may use a different set of months.  

Solar Resource. . Tilt Orientation Factor (TOF) and Total Solar Resource Fraction 
(TSRF) are used to compare the actual site characteristics to the optimal 
characteristics at that site. TOF and TSRF can only be displayed when the NREL 
ï TMY3 weather model is selected. See Weather, Air quality and Clouds on page 
60 for more information. 

To toggle between solar access and solar resource, select:  >View>Define 
Current View, and select Solar Access or Solar Resource. 
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NOTE You can magnify the screen using the zoom tool. See Zoom and Pan 
Tools below. 

The results panel with the solar access/solar resource numbers and edit button 
can be lowered to see the image behind it by pressing the down arrow.  It can be 
raised again by pressing the up arrow.   

The sunpaths are shown in ñclock timeò, meaning the hour lines represent actual 
clock time.  This is in contrast to ñsolar timeò. Solar time is based solely on the 
location of the sun in the sky and can differ from clock time by +/- 20 minutes.  

NOTE The sunpath hour lines do not take into account daylight savings 
adjustments. 

Month labels. The month lines represent the path of the sun on the 21st day of that 
month. Because the sunpaths show clock time, it is not possible to clearly display 
all 12 months of the year.  The sunpaths will always display the summer and 
winter solstices (June 21st and December 21st).  To select which months are 

shown in between the solstices, select:  >View>Configure Current View  and 
select Jun-Dec or Dec-Jun for the month labels. 
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Monthly Solar Access View  

Select >View>Monthly solar access. You will see the bar chart of the 
monthly solar access for the location where you captured data. 

 

The height of the bars and the numbers at the top of each bar, indicate the 
percentage of solar energy available each month for the site-specific shade 
conditions. If there were no shade obstructions, the bars would all indicate 
100%.  If the location were shaded all year round the bars would all indicate 
0%.  

Obstruction Elevation View 

Select >View>Obstruction elevation. You will see the graph showing 
elevation angle of the highest obstruction at each azimuth. The Obstruction 
elevation view can be configured for a range of azimuth values to display the 
elevation data trace every 1 degree, bars showing maximum (or average) data 
within specified azimuth windows, and sunpaths.  
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NOTE Some information from the SunEye may be lost in Obstruction 
elevation  view.The elevation data shows the highest obstruction 
elevation data, open sky that is below an obstruction will not be visible 
in the Horizon view. This is common when there are overhanging 
obstructions, such as a tree branch or light post. 

To configure the display for Horizon view, select Configure or 

>View>Configure Current View.  The Obstruction Elevation Properties 
dialog is displayed. 

 

In the Display tab, select what data will be displayed on the graph: Obstruction 
is the elevation data with one degree resolution; Azimuth window is the section 
of azimuth values for which the maximum (or average) data will be displayed; 
and Sunpaths. Also select which month labels will be displayed on the 
sunpaths, Jun-Dec or Dec-Jun. 
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In the Azim Range tab, select the Azimuth Center, in degrees, eg. 180 for 
south, This value is the center of the x-axis in the graph. Next, select the 
Number of windows that will be displayed and the Azimuth window size in 
degrees. Note that there must be an odd number of Azimuth windows, since 
there is one center window centered around the Azimuth center, and an equal 
number of Azimuth windows on each side of that center window. The Start and 
Stop azimuth values will be automatically computed from the above values. 
Lastly, select whether the Maximum or Average elevation value will be 
displayed for each Azimuth window. Press OK, and the graph will be modified 
with the new settings. 

Select Elevation Table to show a table of the specified Elevation values in the 
Azimuth windows specified, for example, as shown below. Select OK to return 
to the graph. 

 

Full Fisheye View 

Select >View>Full Fisheye. This display option shows the full view of the site 
captured through the fisheye lens of the camera. 


